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Example — Truss 2D

y
T SECT}ON 4 SECTION §
f 7 e -
A\ Y
a
SECTION 1 SECTION 5 SRRTiG
H SECTION 3 SECTION 7 S
F1 F4
SECTION 2 SECTION 6 SECTION 10
. L F
F2 F3
. L1 A L2 L L3 X
E = 210e09N/m” F1 = 280kN
U =0.3 F2 = 210kN
L1=0L2=L3=3.6m F3 = 280kN
H=3.118m F4 = 360kN

ansyd = b =0.050mm
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Example — Truss 2D

Objective:

Compute the maximum deflection

Tasks:

Display the deflection figure? Display member forces?
Topics:

Topics: Start of analysis, Element type,

Real constants, Material, modeling, ele-

ment size for beam models, saving/restoring

ANSYS Example0152
Computational Mechanics, AAU, Esbjerg



Example - title

Utility Menu > File > Change Jobname e GUI
/jobname, Example0152 ¢ Command line entry
x| Enter: Example0152

[/FILM&M] Enter new jobname Ihle ° |

Mew log and error files? [~ Mo

Ok, | Cancel | Helpn |

Utility Menu > File > Change Title Enter: Truss 2D
ftitle, Truss 2D
x|
[/TITLE] Enter new title || °
0] Cancel Help
ANSYS Example0152 4
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Note: An empty #

Example - Keypoints

Preprocessor > Modeling > Create > Keypoints > In Active CS mpering.

G ¥ . # Keypoint number

eneral format: % Keypoint x-coordinate

K#,X,Y,Z Y Keypoint y-coordinate
Z Keypoint z-coordinate

Enter 0,0,0
li\Create Keypoints in Active Coordinate Systen X| Enter 3.6,0,0
[K] Create Keypoints in Active Coordinate System Enter 7. 2,0,0
MPT Keypl_inint.numtfer I | Entel’ 108’0’0
},0,2 Location in active CS5 I ® I I ! Enter 9,3118,0
Enter 4.8, 3.118,0
_ ok | ety | [ _ Hep | Enter 1.8, 3.118.0
|
ANSYS Example0152 )
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Example - Numbering

Utility Menu > PlotCtrls > Numbering Switch on Keypoint numbers
Fan Zoom RFotate ...
View Settings b Fi\Plot Numbering Controls |
Numbering ... [/FNUM] Plot Numbering Controls
Symhbals .. KF  Keypoint numbers ¥ on
Style ?
LIME Line numbers [ off
Fomt Contrals »
Window Controls » AREA  Area numbers [ off
Erase Options >
YOLU Valume numbers [C off
Animate 4
e , MOCDE Mode numbers [ off
Device Options .. R Elem / attrib numbering INI:I numbering j
Redirect Plots i TA4BN Table Marmes I~ off
Hard Copy 4
R SWAL Mumeric contour values [~ off
G P g [MUM] Mumbering shown with ICDIDrs & numbers j
Reset Plot Cirls

=
Capture Image .. [/REPLOT] Replot upon Ok Aapply: IREpl':'t j

Festore Image ...

Write Metafile * (]34 QJ Apply | Cancel | Help |

Multi-Flot Controls .. Press OK

ML lt-vindowr Layout ...

/ Best Quality Image r Example0152 6
Computational Mechanics, AAU, Esbjerg



Example - Lines

Preprocessor > Modeling > Create > Lines > Lines > Straight Line
L,1,2

L,2,3

L.3,4 Create Straig HINT: By clicking with the right-

L,4,5 ® pick O Unpick hand mouse button you shift

L,5,3 S between the Pick/Unpick

L.5,6 P function. This is indicated by

L,3,6 - the direction of the cursor

L,6,2 T arrow:

L,6,7 Minimum =

L2.7 e . - Pick: upward arrow

L,7,1 : bist of Tvens Unpick: downward arrow
Press OK or Cancel
to finish selection

IE @ Epprty
Deset Cancel@®
ANSYS : Example0152
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Example — Move/Modify

1
POINTS

TYFE NUM

ANSYS
Computational Mechanics, AAU, Esbjerg

Example0152

ANSYS

FEE

17 2004

20:49: 53

After reconsidering
the coordinates it is
found that keypoint 6
IS errorneous



Example — Move Single Keypoint
|

AMNSYS Main Menu &
Preferences - Move Single K
Preprocessor r

¥ pi -
Element Type * Pick @ (" Unpick

Real Constants
rMaterial Props

oy Zirerl g {0 Box

Sections € Polyadn ¢ Cirole
E Modeling ™ Loop Se|eC'[ KP6
Create
Operate Count = 0
B Move / Modify :
B Keypoints e R
& 5et of KPs i =L

PaSingle KP) kT KeyD No. =
& To Intersect

Lines
% (% Lizt of Items
Areas
& Yolumes  Min, Max, Inc
Modes

Rotate Node CS |

Elements Il
Transfer Coord
Reverse Normals

Press OK

Copy 0K @ Apply
Reflect

Check Geom Reset Cancel
Delete _

Cyclic Sector Dok 211 Help

Genl plane strn
Update Geom

Meshing Notice bottom left
Checking Ctrls J
zl"*" oot are i o o = —l [KMODIF] Pick or enter keypoint to be moved

ANDT O Example0152
Computational Mechanics, AAU, Esbjerg



Example — Move Single Keypoint

Move Single Ké

¥ Pick " Tpick

Count

Maximuam

= u]

= 1

Mirdimam)
WE

T
Global

= 1

B =
i =
=

LIME{S) AND POSSIELY AREA{S) AMND VOLUME(S) WILL BE ALTERED BY KMOD.
SHOULD THE EMOD COMMAND BE EXECUITED?

li? %
\:r}

I3

Mej |

x|

gl

% Glo)

oordinates

al Cartesian

IE @ bpply

RBeszet

Cancel

Help

ANSYS

Enter
54,3.118

Computational Mechanics, AAU, Esbjerg
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— Press OK
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Example — Move Single Keypoint

ANSYS Example0152
Computational Mechanics, AAU, Esbjerg
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Example — Element Type

Preprocessor > Element Type > Add/Edit/Delete

x|
Defined Element Types: ml‘lbrar? of Element Types x|
Library of Element Types SR UEHIEa MSes
Lirk plastic 23
tapered 54
Fipe 30 finite strain
Rigid 2 node 188 -
Solid
Shell ;I 2D elastic 3

Element type reference number I 1
04 | Aoy | Cancel | Help |

Add... |e Sptions— Belete Press Add
Clase | Help |
ANSYS Example0152 12
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Example -

Element Type

Preprocessor > Element Type > Add/Edit/Delete

Element Types .

Defined Element Types:

x|

Add...

IBEAMS element type options

Cptions for BEAMS, Element Type Ref, Mo, 1

Member force + mament output K&

Output at extra intermed pts KO

Options... |0 Belete

Close |

ANSYS
Computational Mechanics, AAU, Esbjerg

IND intermed pts j
Load offset in terms of K10 ILEH,;IﬂFI LRits j

_ ok | _cancel | e |[o——

Press Options
Press Help to learn more about

Help | the element. Find the table on —
the nex page
Example0152 13



Example — Element Table

Find the following table for the element. Identify how to plot member
forces in longitudinal direction of the beam element - MFORX

| Name | Definition /| o | R
|EL |Element HNumber | i | by
INODES [Element nodes - I, I oY | T
|I'u'IﬂT |Element material mamber | by | by
|1FDLT_T: |Element volume | H | T
|§{C, iz |L|:n:ati|:|n where tesults are reported | T | 3
TEMP Temperatures T1, T2, T3, T4 I
[PRES Pressure P1 at nodes [T, OFFSTL at1]; P2 at 1], OFFST2 at], 1, P3 at 1, P4 at] oY | T
SDIR \&idal direct stress [ 1 | 1
|SEIYT |Eendjng gtress on the element +V side of the heam | 1 | 1
|SEYB |Eendjng gtreas on the element -¥ side of the beam | 1 | 1
|SI'u'IﬁX |I'u'I aitron stress (direct stress +bending stress) | 1 | L
|SI'u'IIN |Mi1]j1nmn stress (direct stress - bending stress) | il | i
[EPELDIE. \tuxial elastic strain at the end [ 1 || 1
|EPELEIYT |Bending elastic straiti on the element +V side of the heam | 1 | 1
|EPELEIYB |Eendjng elastic straiti on the element -V side of the heam | 1 | 1
[EPTHDIR \&idal thermal strain at the end [ 1 | 1
|EPTHEIYT |Eendjng thetthal strain on the element +7 side of the heam | 1 | 1
|EPTHEYB |E endinng thermal strain on the element -¥ side of the beam | 1 | 1
[EPINAYL [nitial aial strain in the element [ 1 || 1
|I'u'IFOR()Q k] |I'u'I etber forces in the element coordinate system X and ¥V direction | 2 | T
|MMDME |I'u'I etnber moment it the element coordinate system Z direction | 2 | Ky
ANSYS Example0152

Computational Mechanics, AAU, Esbjerg

14



Example — Element Table

Find also the following table in the Help function

Tahle 3.2. BEAMS3 Hem and Sequence Numbers (KEYOPT(9)=0) @
‘ Output Quantity Name I — g IBEAMS element type options ]
" -

| T | T — Options for BEAMS, Element Type Ref, Mo, 1

| G2 | L [ Member force + mament output KB

| SEYB | LS

EFELDIR LEFEL -

I i I —— ”: Output at extra intermed pts K9 'y IN':' intermed pts j

| EPELEVE | LEFEL [ Load offset in terms of K10 i

| FFTHDIR | LEFTH [ II‘EF"EIﬂFI units j

| FFTHEYT | LEFTH [

| EPTHEYE | LEPTH [] oK Cancel Hel

P

| EFINAXL | LEFTH [

| SMAX | WIATSC [
.ILIIIIIIlsmmIIIIIIIJIIIIIIImwmIIIIIIILIIIII.'IIIIIIJIIIIIIZIIIIIILIIIII&IIIIII I.
. MFOR | SMISC | | 1 | 7 -
.I*IIIIIII[\Hmf.IIIIIII|IIIIIIISMH:IIIIIIII*IIIIII_IIIIIIIlllIIII!IIIIII*IIIIIISIIIIIIII.

| MMOMZ | SMISC | | 6 | 12

| Pl | SMIC | | 13 | 14

| OFFaTI | SMISC | |

| o | aC | | Remember MFORX, SMISC,1,7 —

| OFFST2 | SMISC | | 19 | 20

| F3 | SMIC | | 21 | =

| P4 | SMISC | | - | 22

| | Pseudo Node

| 1 2 |3 4

| TEMP | LEFE | 1 | 2 | 3 |

ANSYS Example0152 15
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Example - Element Type

Preprocessor > Element Type > Add/Edit/Delete
x|

Defined Element Types:

IBEAMS element type options ]

Cptions for BEAMS, Element Type Ref, Mo, 1

Member force + mament output K&

Output at extra intermed pts K9 IN.;. inter med pts j

Load offset in terms of K10 ILenguq Lnits j

DKO_—|~ Cancel | Help |

Add... Options... Delete
E N G| S ] — Press OK
Cluse:‘—‘ Help |
ANSYS - Press Close Example0152 16
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Example — Real Constants

Preprocessor > Real Constants > Add
Real Constants

Defined Feal Constant Sets

MOME DEFIMED

X

Add... @

=1L
L | | R

trelete |

Close |

Help |

ANSYS

Element Type for Real Col

Choose element type:

Type 1 BEAMI

Place the cursor
on the relevant
element and
press OK

[ L= =]

Example0152

Computational Mechanics, AAU, Esbjerg
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Example - Real Constants

Preprocessor > Real Constants > Add

lReal Constants for BEAMS3

Element Type Reference Mo, 1
Real Constant Set Mo,

Cross-gectional area AREA

Area moment of inertia 77

HREENAE

Real Constants

Defined Real Constant Sets

X

2 -7
>-2083e Press Close
Total beam height HEIGHT -
to finish
Shear deflection constant SHEARZ
Initial strain ISTEM
Added mass/unit length  ADDMAS
oK Apply Cancel | Help | Edit... | Delete |
®
Cloze @ HI::II_I
Press OK
ANSYS Example0152 18

Computational Mechanics, AAU, Esbjerg



Example - Material Properties

Preprocessor > Material Props > Material Models
I\Define Material Model Behavior

wWaterial  Edit Help

— Material Models Defined

o]

Double Click
to step in the

— Material Models Available mate”al tree
& Material Model Nurmber 1 ] ﬁ Structural =]
@ Linear
8 Elastic
@ [sofropicll g
€ Orthotropic
@ anisotro [T, Isotropic Properties for Material N X|
Monlinear
© Density Linear Isofropic Material Properties for Material Murmber 1
Thermal Expansior
€ Damping -
| 8 Friction Coefficient
= ] | Temperatures I
femn | e BA=dmwri= ] Teie
‘ ILI_‘ | EX
PR
Add Temperature | Delete Temperature Graph
k. Cancel Help
ANSYS Example0152 19
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Example - Material Properties

Preprocessor > Material Props > Material Models

Linear Isotropic Properties for Material [

Linear Isotropic Material Properties for Material Mumber 1

i
Temperatures
EX 210e9
PRI 4

x/| Enter: Click here
Modulus of elasticity to Close
Enter: ‘

add Temperature | Delete Temperature |

® [K

Cant

Press OK —

ANSYS

Computational Mechanics, AAU, Esbjerg

Poisson’s ratio

F\nofine Material Model Behavior

Material Edit Help

— Material Models Defined

& Material Model Nurnber 1
& Linear Isotropic

— Material Models Available

iz @8 Structural
|ﬁ Linear
8 Elastic

€ Orthotropic
& Anisofrapic
MNonlinear
& Density
Thermal Expansion Coef
# Darmping

(] & Friction Coefficiant
If (Zm | lemw W chmwrim] inbimune
»

o™

Example0152
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Example — Mesh Attributes

Preprocessor > Meshing > Mesh Attributes > Line Attributes > Picked Lines

Line Attribute

% pick @ Hmpick

i+ Bingle i~ Box

" Polygon {" Circle
i Loop

Count
Maximuam

1
z
Minimam 1
1

Line No.

{¥ List of Items

- Min, Max, Inc

0E @ Apply

Deset Cancel

Pick All Help
ANSYS—— Press OK ——

Select All Lines

li\Line Attributes _ X|

[LATT] Assign Atributes to Picked Lines

MaT  Material number -
REAL Real constant set number I 1 d
TYFE Element type number I 1 BEAM3 j

SECT Element section

Pick Crientation Keypoint(s)

INnne defined j
[~ Mo

4 | dpphy | Cancel | Help |

Example0152

Computational Mechanics, AAU, Esbjerg
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Example - Meshing

Preprocessor > Meshing > Size Cntrls > ManualSize > Lines > Picked Lines

Element Size fiY Element Sizes on Picked Lines x|

—— & i [LESIZE] Element sizes on picked lines
SIFE Element edge length

(o Single " Box

|

MDY  Mo. of element divisions
- Folygon  { Cirecle

" Loop (MDIV is used only if SIZE is blank or zero)
. KYNDIV SIZE,NDIV can be changed v Yes
Count =
. Masimum = 1 SPACE Spacing ratio I
S_elect/Plck pcmm = —
L|neS tO e ANGSIZ Division arc (degrees) I
Specify [ use ANGSIZ only if number of divisions (NDIV) and
h . {* Lizt of Items element edge length (SIZE) are blank or zerao)
;:nes SSIIZe t " Min, Max, Inc Clear attached areas and volumes [ Mo
or — selec
All lines '
TS m— Ok | Apply | Cancel | Help |
Reset Canpel |
Pick ALL Hellp |
— Press OK when finish with selection Enter 1 —
ANSYS Example0152 22
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Example - Meshing

Preprocessor > Meshing > Mesh > Lines

% tick @

g e P
L2 UIIEITE

[ Single {" Box ‘

" Polygon {" Circle

o Select individual lines to be meshed by Picking

Count = I

Maximam

Minimam

Line Ho.

NB: It is often necessary to “Clear” the model for
R example if Element Type is to be changed

- Min, Max, Inc

Select all lines defined to be meshed

OE Lpply
Beset Cencel
Bick 211 Help
[ )
ANSYS

Example0152 23
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Example — Analysis Type

Write Database Log :

Wiite D atabase Log to Directories:
i @ o hadminiztrator
Cancel |
= ot

| [=+ DOCUMEMNTS .&Nj Hel |
E= ADMINISTRATOI P
3 Cookies

3 Dokumenter

LI £ Foretrukne ﬂ
Solution > Analysis Type > New Analysis <t Al

IDatahase Log [ Igw] ;I I = ;I MHetwark. .. |
m New Ana I?ISis | EI I'W'rite non-ezzential cmds as comments LI

[ANTYPE] Type of analysis

File > Write DB log file
Enter “example0152.Igw”

k

" Modal

" Harmonic
" Transient
" Spectrum

" Eigen Buckling
" Substructuring PreSS OK

oK @& Eateel Help |

ANSYS Example0152 24
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Displacement > On Keypoints

Select keypoint 1

¥ pick &— Trpick

Select UX and UY —

v Single {" Box

P e e - I\ Apply U,ROT on KPs t x|
< Loy [CK] Apply Displacements (U,ROT) on Keypoints

Count = 0 Labz DOFs to be constrained all D'ZIF

Meaximum = Z Ei °

Minimum = 1 ROTZE

FeyP Ho. =

{* List of Ttems Apply as ICDnstant valle j

If Constant value then:

YALUE  Displacement value I

i Min, Max, Inc

| KEXPND Expand disp to nodes? [~ Mo
R :‘:pplx Ok .J apply | Cancel | Help |
Heset Cancel
Pick All Help
— Press OK
ANSYS Example0152 25
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Displacement > On Keypoints

Apply U,ROT Select keypoint 4
¥ pick &— Trpick
Select UY
v Single {" Box
ol LA I Apply U,ROT on KPs x|
o boos [CK] Apply Displacements (U,ROT) on Keypoints
Count = 0 LabZ DOFs to be constrained Al DihF
Meaximum = Z Ei ®
Minimum = 1 ROTZE
FeyP Ho. =
{* List of Ttems Apply as ICDnstant value j

If Constant value then:

YALUE  Displacement value I

i Min, Max, Inc

| KEXPND Expand disp to nodes? [~ Mo
R :‘:pplx Ok .J apply | Cancel | Help |
Heset Cancel
Pick All Help
— Press OK
ANSYS Example0152 26
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Force/Moment > On Keypoints

Apply F/M on |

@ pick @—Ftrptor—

v 5 ingle { Box

" Polygon { Circle
[ Loop

Count

Maximum

[l [

Minimum

EeyP MNo.

{¥ List of Items

- Min, Max, Inc

Select keypoint 1

Change to FY

Fl\ Apply F/M on KPs ]
[FK] Apply Force/Moment on Keypoints

Lab  Direction of force/mom P I,:x,— T|

Apply as ICnnstant value j

CE @ Eppty
Feset Cancel
Pick A11 Help
ANSYS

If Constant value then:

VALUE Force/moment value I [

oK Tl Apply Cancel |

Press OK to finish Enter -280

Help |

Example0152 27
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Force/Moment > On Keypoints

Apply F/M on |

@ pick @—Ftrptor—

v 5 ingle { Box

" Polygon { Circle
[ Loop

Count

Maximum

[l [

Minimum

EeyP MNo.

{¥ List of Items

- Min, Max, Inc

Select keypoint 2

Change to FY

Fl\ Apply F/M on KPs ]
[FK] Apply Force/Moment on Keypoints

Lab  Direction of force/mom P I,:x,— T|

Apply as ICnnstant value j

CE @ Eppty
Feset Cancel
Pick A11 Help
ANSYS

If Constant value then:

VALUE Force/moment value I [

oK Tl Apply Cancel |

Press OK to finish Enter -210

Help |

Example0152 28
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Force/Moment > On Keypoints

Apply F/M on |

@ pick @—Ftrptor—

v 5 ingle { Box

" Polygon { Circle
[ Loop

Count

Maximum

[l [

Minimum

EeyP MNo.

{¥ List of Items

- Min, Max, Inc

Select keypoint 3

Change to FY

Fl\ Apply F/M on KPs ]
[FK] Apply Force/Moment on Keypoints

Lab  Direction of force/mom P I,:x,— T|

Apply as ICnnstant value j

CE @ Eppty
Feset Cancel
Pick A11 Help
ANSYS

If Constant value then:

VALUE Force/moment value I [

oK Tl Apply Cancel |

Press OK to finish Enter -280

Help |

Example0152 29
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Force/Moment > On Keypoints

Apply F/M on |

@ pick @—Ftrptor—

v 5 ingle { Box

" Polygon { Circle
[ Loop

Count

Maximum

[l [

Minimum

EeyP MNo.

{¥ List of Items

- Min, Max, Inc

Select keypoint 4

Change to FY

Fl\ Apply F/M on KPs ]
[FK] Apply Force/Moment on Keypoints

Lab  Direction of force/mom P I,:x,— T|

Apply as ICnnstant value j

CE @ Eppty
Feset Cancel
Pick A11 Help
ANSYS

If Constant value then:

VALUE Force/moment value I [

oK Tl Apply Cancel |

Press OK to finish Enter -360

Help |

Example0152 30
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Example - Save

1
ELEMENT3A

Display of Analysis model

AMSYS Toolhar

Save the model
[ SavE_DB | RESLIM_DB ‘ QUIT | F'DWRGRF'HI E-CAE |

I

ANSYS Example0152 31
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Example - Solve

Solution > Solve > Current LS

ANSYS Main Menu @

Preferences

Preprocessor

B Solution
Analysis Type

pml o Solve Current LoadStep x
sty Opts Solve Current Load Step i x|

= rrE"t 5 o [SOLVE] Begin Solution of Current Load Step

From LS Files

Partial Solu Review the summary information in the lister window (entitled
Adaptive Mesh "/STATUS Command"), then press OK to start the solution.
FSI Set Up

ADAMS Connection
Unabridged Menu | e T
General Postproc Ok, Cancel Help
TimeHist Postpro

Topological Opt
ROM Tool
Design Opt
Prob Design
Radiation Opt
Run-Time Stats
Session Editor
Finish

HEREEEHEEBEA

Press OK

S Example0152
Computational Mechanics, AAU, Esbjerg




_ i ) Solution is done!

Example - Solve

Press Close

Press here
to Close
.
i1 /STATUS Command B x|
File
SOLUTIOW OPTIOHS
PROBLEM DIHEWSIOWALITY. . . . . . ... .. .. -
DEGREES (OF FREEDOH. . . . . . L4 ROTZ
AHALYSIS TYPE - o v v v e e w e e e e e STATIC (STEADY-STHTE]
LOAD STEP OPTIONS
LOAD STEF HUMBER. . . . . . v v o o v w v o 1
TIHE AT EMD OF THE LOAD STEP. . . . . . . . .. 1.0000
HUHBER OF SUBSTEPS. . . . . . . . . . . .. .. 1
STEP CHAWGE BOUMDARY COMDITIONS . . . . .. .. HO
PRINT OUTPUT COWTROLS . . . . . . o . . . . - . O PRINTOUT
DATABASE OUTPUT COMTROLS. . .+ . o v v v v - ALL DATH HRITTEH
FOR THE LAST SUBSTEP
ANSYS Example0152 33
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Example - PostProcessing

General Postproc > Plot Results > Deformed Shape

Plot Deformed Shape | x|

[FLDISF] Flot Deformed Shape
KUND  Items to be plotted

" Def + undeformed @

" Def + undef edge

oK | Apply Cancel | Help |

Select “Def+undeformed”
and Press OK

ANSYS Example0152 34
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Example - PostProcessing

DISFLACEMENT

1

STEF=1
GUE =1
TIME=1

— Read Maximum displacement: DMX

ANSYS Example0152
Computational Mechanics, AAU, Esbjerg
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Example — Element Table

AMNSYS Main Menu

AMSYS Main Menu

Preferences
Preprocessor
Solution
= General Postproc
Data & File Dpt:
Results Summal
Read Results
Failure Criteria
Plot Results
List Results
Query Results
= Options for Out
Results Viewer
Write PGR File
MNodal Calcs
=W lement Table
Define Table
Plot Elem Tah
List Elem Tab
Abs Value Of
Sum of Each !
Add Items
Multiply
Find Maximun
Find Minimum
Exponentiate
Cross Produc
Dot Product
Erase Table
Path Operation:
Load Case
Check Elem Sha
Write Results
ROM Operation:

-

J

FlimEEA

Preferences
Preprocessor
Solution
E General Postproc
Data & File Dpts
Results Summary
Read Results
Failure Criteria
Plot Results
List Results
OQuery Results
Dptions for Dutp
Results Viewer
write PGR File
MNodal Calcs
& Element Table
Plot Elem Table
List Elem Table
Abs value Option
Sum of Each Item
Add Items
Multiply
Find Mazimum
Find Minimum
Exponentiate
Cross Product
Dot Product
Erase Table
Path Operations
Load Case
Check Elem Shape
Write Results
ROM Dperations

Mmoo

l

Element Table Data

Currently Defined Data and Status:

Label

WCME DEFINED

Item Comp

@ Add... |

Close |

Time Stamp

Update |

Status

Delete |
Help |

El

|

ANSYS

Computational Mechanics, AAU, Esbjerg

Example0152

~ Press Add to add the first data line
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Example — Element Table

l\Define additional Element Table Items x|
[AWPRIN] Eff MU for EQY strain |

[ETABLE] Cefine Additional Element Table [tems

Lab Lizer label for item I

Item,Comp Results data iem DOF solution Translation U
Stress Ly
Strain-total Uz
Strain-mech+thrm gl |Rotation  ROTX
Modal force data ROTY -
Energy
Error estimation _vJ Translation UxX

{For "By sequence num", enter sequence
no. in Selection box, See Table 4.xx-3

in Elements Manual for seq. numbers. )

Ok, | Apply | Cancel | Helm |

Scroll down in this menu to find the line “By sequence number” —

ANSYS Example0152
Computational Mechanics, AAU, Esbjerg



Example — Element Table

Fi\Define Additional Element Table Items x|

[AWPRIN] Eff NU for EQY sirain I

[ETABLE] Define additional Elerment Table Items

Lab User label for item I

Item,Comp Results data iem Strain-thermal -
Strain-plastic MMISC,
Strain-creep LS,
Strain-other LEFEL,
Contact LEFTH, bl
Cptimization |

By sequence num SMISC,1 @

{For "By sequence num", enter sequence
na. in Selection box, See Table 4.xx-3
in Elements Manual for seq. numbers. )

(]34 OJ Apply | Cancel | Help |

— Enter 1 as found in table 3.2 —

— From table 3.2 MFORX, SMISC,1,7

ANSYS Example0152
Computational Mechanics, AAU, Esbjerg

Press OK —




Example — Element Table

AMNSYS Main Menu

AMSYS Main Menu

Preferences
Preprocessor
Solution
= General Postproc
Data & File Dpt:
Results Summal
Read Results
Failure Criteria
Plot Results
List Results
Query Results
= Options for Out
Results Viewer
Write PGR File
MNodal Calcs
=W lement Table
Define Table
Plot Elem Tah
List Elem Tab
Abs Value Of
Sum of Each !
Add Items
Multiply
Find Maximun
Find Minimum
Exponentiate
Cross Produc
Dot Product
Erase Table
Path Operation:
Load Case
Check Elem Sha
Write Results
ROM Operation:

-

J

FlimEEA

Preferences
Preprocessor
Solution
E General Postproc
Data & File Dpts
Results Summary
Read Results
Failure Criteria
Plot Results
List Results
OQuery Results
Dptions for Dutp
Results Viewer
write PGR File
MNodal Calcs
& Element Table
Plot Elem Table
List Elem Table
Abs value Option
Sum of Each Item
Add Items
Multiply
Find Mazimum
Find Minimum
Exponentiate
Cross Product
Dot Product
Erase Table
Path Operations
Load Case
Check Elem Shape
Write Results
ROM Dperations

Mmoo

l

Element Table Data

Currently Defined Data and Status:

Label

WCME DEFINED

Item Comp

@ Add... |

Close |

Time Stamp

Update |

Status

Delete |
Help |

El

|

ANSYS

Computational Mechanics, AAU, Esbjerg

Example0152

- Press Add to add the second data line
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Example — Element Table

Fi\Define Additional Element Table Items x|

[AWPRIN] Eff NU for EQY sirain I

[ETABLE] Define additional Elerment Table Items

Lab User label for item I

Item,Comp Results data iem Strain-thermal -
Strain-plastic MMISC,
Strain-creep LS,
Strain-other LEFEL,
Contact LEFTH, bl
Optirization (-

SMISC, 7@

By sequence num
{For "By sequence num", enter sequence

na. in Selection box, See Table 4.xx-3

in Elements Manual for seq. numbers. )

(]34 OJ Apply | Cancel | Help |

— Enter 7 as found in table 3.2 —

— From table 3.2 MFORX, SMISC,1,7

ANSYS Example0152
Computational Mechanics, AAU, Esbjerg

Press OK —




Example — Element Table

Element Table Data |

Currently Defined Data and Status:

Label Itern Cormp
SMIS1 SMIS 1

Add...

Close | ®

Tirme Stamp
Time= 1.0000
Time= 10000

Update |

{Current)
{Current)

Delets |
Heln |

x|

Press Close

ANSYS
Computational Mechanics, AAU, Esbjerg

Example0152
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Example — Plot Line-Element

AMNSYS Main MMenu

AMNSYS Main MMenu

®|

Preferences
Preprocessor
Solution
B General Postproc
Data & File Opts
Results Summary
Read Results
Failure Criteria
A Plot Results
Deformed Shap
=ERContour Plot
Nodal Solu
Element Solu
Elem Table
Line Elem Res
vector Plot
Plot Path Item
Concrete Plot
List Results
Query Results
Options for ODutp
Results Yiewer
Write PGR File
Modal Calcs
Element Table
Path Operations
Load Case
Check Elem Shape
Write Results
ROM Operations
Submodeling
Fatigue
Safety Factor
Define,/Modify
[ .

J

Preferences
Preprocessor
Solution
B General Postproc
Data & File Opts
Results Summary
Read Results
Failure Criteria
A Plot Results
Deformed Shape
B Contour Plot
Nodal Solu
Element Solu
Elem Table
Yector Plot
Plot Path Item
Concrete Plot
List Results
Query Results
Options for ODutp
Results Yiewer
Write PGR File
Modal Calcs
Element Table
Path Operations
Load Case
Check Elem Shape
Write Results
ROM Operations
Submodeling
Fatigue
Safety Factor
Define,/Modify
[ .

J

B Plot Line-Element Results

[FLLS] Plot Line-Element Result
Labl Elem table item at node I

Labl Elem table item at node ]
Fact Optional scale factor

KUND Items to be plotted

dpphy Cancel

——@ Ok |

ISMISI vl
- -]
Il

& Def shape only
¢ Def + undeformed
" Def + undef edge

| Help |

— Press OK

Ef

|

ANSYS

Example0152

Computational Mechanics, AAU, Esbjerg

Change to SMIS7 —
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Example — Plot Line-Element

1
LINE 3TRE33

ANSYS Example0152
Computational Mechanics, AAU, Esbjerg
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Example — Comments/Questions

* Try Link elements instead of beam
elements?

 The “example0152.lgw” can be edited In
“Notepad”

 Will the number of elements affect the
solution?

ANSYS Example0152 44
Computational Mechanics, AAU, Esbjerg



File menu

File Select List Plot PlotCirls \WorkPlane Parameters Macro MenuCirls  Help

Clear & Start Mew ... —
Change Jobname ... You can include commands to be
Change Directory ... executed when the program starts up in ——
izh Title ... .
i the start71.ans file.
BESTE dotaaine al li\Clear Database and Start New
Resume fram ...
Save as Jobname.db [/CLEAR] Clear database and start nemw!
Save as .. Bec stark s gl Lo L
Write DB log file ... @ Read file
" Do not read file
Read Input from ...
Switch Cutput to »
List * x| _ cancel | e |
File Operations 4
dilseile e Clears (zeros out) the database stored in
Impart : memory. Clearing the database has the same
Bt effect as leaving and reentering the ANSYS
Repart Generatar .. program, but does not require you to exit.
/  Exit... Example0152

Computational Mechanics, AAU, Esbjerg
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